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Introduction to Microsoft® Publisher® 2010: Tools You May
Need
1. Why use Publisher instead of Word for creating fact sheets, brochures, posters,

newsletters, etc.?
While both Word and Publisher can create documents that seem fairly similar at first glance, the
underlying structure of each is markedly different.


Word treats a document as a continuous flow of characters, which have to be formatted
“in‐line”. Continuous flow characters does not allow for flexible and precise page layout
and design.



Publisher is “object‐oriented”, meaning that it treats a document as a collection of
separate and distinct objects which can be moved, edited, or deleted completely
independent of any other objects in the document. Images can also be placed outside of
the document page area to be used as a parking space. Note: PowerPoint is also an object
oriented program and therefore similar.

So…which one should you use and why?1
IF YOU WANT TO CREATE

USE THIS
PROGRAM

WHY?

Graphically rich print and e-mail
newsletters

Publisher

Precise control over positioning text with images and other design elements.

Graphically rich catalogs

Publisher

Pre-designed catalog publications and the Mail and Catalog Merge Wizard.

Greeting cards

Publisher

Greeting card types and designs you can customize for all your business and personal needs.

Consistently branded business
communications and marketing
materials

Publisher

Master Design Sets that create a coordinated look and feel for your company letterhead, business
cards, brochures, and labels.

Posters or banners

Publisher

Poster and banner designs with easy width and height choices to match your needs.

3- or 4- panel brochures or flyers

Publisher

Many designs to choose from with optional space for customer addresses, and order, response, or
sign-up forms.

Business cards

Publisher

Design types to match all of your business communications and marketing materials.

Design publications to be
commercially printed

Publisher

Support for large jobs that require the services of a commercial printer, including composite CMYK
PostScript output and advanced print settings for better color separations.

Documents with a table of
contents and index

Word

Indexing and table of contents features allow you to create a professional published document.

Long documents

Word

Features specific to research papers, business plans, or other longer documents including page
numbering, footnotes, endnotes, and annotations.

Legal documents

Word

Legal document support with features such as line numbering, restricted access to sensitive
documents, and checks for hidden text.

Short, simple documents (memos Word
or letters)
Document sharing and
collaboration

Word

Templates and Wizards that allow you to choose style and function, as well as content for the
documents you write every day.
Document Workspaces allow colleagues to work together on documents by using task lists, using
links to resource materials, and storing related or supporting documents in a document library.

Handwritten notes and comments Word

With Tablet PC ink features, you can take handwritten notes or mark up Word documents.

Documents with XML support

Word

The Extensible Markup Language (XML) feature saves hours by allowing creation of document
elements that are both searchable and reusable.

Documents requiring review or
editing

Word

Change tracking, inline comments, side-by-side compare, compare and merge, compare versions,
and text highlighter features support document revision and collaboration.

1

Table from http://office.microsoft.com/en‐us/help/word‐or‐publisher‐use‐crabby‐s‐special‐recipe‐to‐decide‐HA010175759.aspx
taken 1/17/2014
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2. Templates: Publisher has many pre‐formatted templates, which allow you to get your publication
completed with minimal formatting work. Unfortunately, these templates give your publication a
‘canned’ or ‘synthetic’ look and feel. 
In addition, some of the templates will violate the rules of good design (Proximity, Alignment,
Repetition, and Contrast) and therefore should not be used.

ACTIVITY
With that being said, let’s open Publisher &
explore one of the Newsletter templates
available in Publisher. (Top Notches
template)
After you open this template, what do you
like about the template?

What do you NOT like about the
template?
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3. Blank Document:
To get away from a
canned look you
would want to start
a new document
from scratch. To
start from scratch,
you would select
New located under
the File tab.

Note: If you are trying to get back to the blank document from any template, click on Home located at
the top of the page.

After selecting New, you will be able to choose what type of document you want. I’m going to
choose Blank 8.5 x 11 in the portrait orientation since it is most like a fact sheet or flyer and prints
on a standard size page and orientation.

Now you have a blank document to get started creating a fact sheet.

ACTIVITY
Let’s now start a new blank document from scratch. You can choose whichever page
orientation and size you prefer from the blank sizes that best meets your needs.
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4. Page Insertion & Navigation: After you have started a new document, you may want to add
additional pages and then navigate between pages to edit. To see how many pages are in your
document, look at the left hand side of your screen under Page Navigation.
If your document has more than one page, it could look like the example located below. You will
know what page you are on in the document because it will have a yellow‐gold area around the
page you are currently viewing.

Note: The example above has 2 pages and page 2 of the document is currently being viewed as it has a
yellow-gold area around page 2.

a. If you only have one page in your document, but
you know you need 4 pages total, you will need to
insert pages into the document. To insert pages,
click on the Insert tab located at the top of your
screen and click on the down arrow under Page.
Choose the Insert Page… option. When the Insert
Page dialog box appears:
i indicate how many pages you want
ii

where you want to insert the pages

iii


and additional options

i

ii

Based on
where you
need the
pages

iii

Note: each menu item which ends in an ellipses (three dots) leads
on to a further dialog box from which you can select more options.

Once you have inserted the pages and in the location you wanted them, click OK.
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b. To navigate to a page, in the Page Navigation area (see example for 4), click on the page
you want and Publisher will jump you to the selected page.
c. You can also zoom in on your document, so that it appears bigger. (It does not actually
change size ‐ it just appears bigger on your screen, so that you can more easily position
frames and so on). Holding down the “Ctrl” key on your keyboard and move the wheel
on your mouse up or down to zoom in and out respectively.

ACTIVITY
Let’s now insert pages into our blank document to have 4 pages total and save it on our
desktop as “PublisherTest”.
Warning: always save your work often so that you don’t lose anything.

5. Text Box: Since Publisher treats everything as an object instead of a continuous flow of
characters, you need to use text boxes to insert any text you want in your document.
a. Inserting a Text Box: to insert a Text Box in your document, you would select the Draw
Text Box icon located in the under the Insert tab. You would only need to click on the icon
once. You would then move your cursor to the document you are working on. Note: If you
have selected the Text Box, your cursor will change to a “cross hairs” when the cursor is on
the viewing page. By going to the desired location on the page of the document and left

clicking you can insert a Text Box.
Once the Text Box has been inserted, you can type in the text you want. You can also
format the text: font, size, color, bold, italicized, and underlined. When you want to type
text in a Text Box, you click on the Text Box and it will become selected with
circles at the corners and center points. Text boxes in your document can be
all sizes, with different types of fonts, character sizes, and colors. (See
example to the left). Note: If you already have the text in a Word document, you
can copy and paste it into the Text Box to save time.

Publisher allows you fine control over how your text
appears. The Font Selection box shows you font choices
available on your computer and what each font will look
like.
But that´s not all! From the Format menu, you can select any number of different
formatting options, including borders, colors, indenting, fancy initial letters and so on.
Below are some of the little known font formatting options that will be beneficial for
you.
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The A’s icons with the up and down arrow (pictured left) let you automatically
incrementally increase (up arrow) or decrease (down arrow) selected text simply by
clicking on either one of these icons. Each click increases/decreases one size.
The Aa icon with the down arrow will let you format any text you select to be
Normal, Small Caps, or All Caps. Normal is useful for changing any text you paste
in a text box that was originally in all caps.

The AV icon with the down arrow will let you format any of the spacing
between characters of the text you select. This option is useful if you want to
use a font that is a little hard to read because the characters are a little close
together (see EMSC example below). To spread the characters of the text, you can
choose Loose, Very Loose, or More Spacing… if you need more options. This
is also very useful when you are trying to make fonts align (one of the principles
of design. See section #2 Templates for the 4 principles of design).

EMSC

EMSC

Warning: always use spell check for all text boxes!

b. Adjusting a Text Box Size: If a Text Box is selected, you can make a Text Box taller,
shorter, wider, or narrower by moving your cursor to one of the corners until it becomes
a double arrow (
). Holding down the left mouse button you can drag to re‐adjust the
size of the Text Box.
c. Moving a Text Box: If you decide you want to change the layout of your document and
you need to move a Text Box, you can do that in Publisher since the Text Box is an object.
To move a Text Box to a new location in your document, make sure the Text Box is
selected. Then move your cursor to any of the Text Box borders until you get a 4‐way
arrow ( ). While holding down the left button on your mouse, you can drag the entire
Text Box to the new location. Note: A Text Box is selected when it has circles at the corners
and midpoints of the box (see example for 5a on previous page)

d. Paste Special into Text Boxes: If you already have text in another location or document
that you want to paste into your Publisher document, but do not want to paste in the
formatting, font style, font size, etc., then you would use the Paste Special option. The
Paste Special option is located under the Paste on the Home tab. To see the pasting
options, click on the down arrow. After you have copied the text you want to paste into
your Publisher document, place your cursor in the Text Box the text is to be pasted into.
Click on the down arrow under the Paste icon. Several options will be available to you:
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The A option will keep only the text. What that
means is the text you paste in using this option will
be formatted to whatever settings you have set for
the inserted text box. If you have not set any
formatting yet, the text will paste in for whatever
default text size and style is on your computer –
likely the default is Calibri 10 pt. This option is the
same as selecting the Paste Special… option and
choosing Unformatted Text (See example of how the
font looks on the left)

The option with the blue arrow will merge the
formatting between the original document and the
one you are pasting into. If you compare the text in the
example above to the example to the left, you will
notice differences in the font style as well as spacing in
the text box even though it is the same text and same
size text box.

The option with the little page is the simple paste
option. This option will paste all formatting that was
applied to the text you copied from and will paste that
formatting into your Publisher document.
Note: If you want the copied text to keep its original
formatting, you can simply select Paste.
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e. Linking Text Boxes: If your Publisher document has
predetermined Text Box sizes that cannot change in
shape and size such as in a newsletter, you might have
text that is too long for one Text Box and needs to go into
another Text Box (overflow). To tell if the text you pasted
into a Text Box is longer than the size of the Text Box,
click on the text box. If the circles and boxes surrounding
the text box are red instead of clear and if you have a …
then the text is too long for the text box.
To have the extra text go into another (overflow) Text Box, you can cut and paste the
part that does not fit. But an easier tool available in Publisher is to link the text boxes. By
choosing the link tool as you add more text, it will link over to the other linked Text
Box(s). As long as the link function is enabled, as you add more text it will flow into the
linked text box(s).
To link text boxes:
 First add a text box – if you do not already have one inserted


Then select the Text Box you want to
link from



Click on the Create Link icon located
on the Fomat tab



Then move your cursor over the
Text Box you want to link to. Once
your cursor is over this other Text
Box, the cursor will look like a
pitcher that is slightly tipped with
letters flowing out like water. (see
example to right)



Left‐click your mouse inside of this other Text Box and your text that is too long
in length for the original Text Box will link over to this other Text Box.

Note: You can tell if a text box is linked to another text box by clicking on it and seeing if there is an
arrow inside of a box and which way the arrow is pointing like in the example above.
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f. Hyphenation: Whether you type in or paste text, Publisher will default to hyphenating
the text if it needs to go onto multiple lines. (See previous example.)
You will likely want to turn off the hyphenation when you are creating your document.
To turn off hyphenation:
 First you will need to select the text—not the Text Box


Then go to Text Box Tools Format tab,



Click on Hyphenation



You will then get a Hyphenation dialog box (See example below.)



Uncheck Automatically hyphenate this story and select OK. It will turn off the
hyphenation for the selected text.

Note: You will have to turn off the hyphenation for each text box in your Publisher document.

ACTIVITY
Let’s try creating a couple of text boxes on one page, adjusting their sizes, moving them around in
relation to each other, and adding text by typing and/or pasting from another document.
Then link the text boxes.
As a final step, remove the hyphenation from all of your text boxes.
6. Images: Working with a picture or image in Publisher is much the same as working with a Text
Box.
a. Inserting a Picture or Image: When you want to insert a picture or image in your
Publisher document, you click on the Insert tab. You will then see several picture related
options to choose from.
Picture: Publisher allows you to insert pictures from other locations such as your desktop
or a shared drive.
Warning: You should NOT use a picture or image from a website or a picture that
someone other than you took unless you have permission from the other party.
Using pictures/images without permission is copyright infringement and
could incur you or your office a substantial fine ($5,000+/image).
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Clip Art: Microsoft has a large library of clip art which is free and copyright free so you can
use it in any publication.
Picture Placeholder: you can insert an empty picture frame as a holding place if you plan
on inserting a picture/image later.
To insert a picture or image, you would only need to choose one of the 3 options listed
above. If you chose Clip Art, you will be able to search for a
picture/image.
If you find a clip art you want, simply click on it. Publisher
will default to putting the picture/image in the center of page
in the document you are working on. If you do not find a
picture/image you like, type in a new search word until you
find a picture/image that fits your needs.
If you chose Picture an Insert Picture window will open that will let you navigate to an image.
For Picture Placeholder, if you click on it, Publisher will default with a black picture frame in
the center of the page you are viewing. You can then move and/or adjust the frame for an
image later.
b. Adjusting the Picture/Image Size: If a picture/image is selected, you can make it larger or
smaller by moving your cursor to one of the corners of the picture/image until it becomes a
double arrow (
). Holding down the left mouse button you can drag to re‐adjust the size
of the picture/image.
Warning: If you do not resize the picture/image from the corner, it will distort the picture/image.

c. Moving a Picture/Image: If you decide you want to change the layout of your document
and you need to move a picture/image, you can do that in Publisher since the picture/
image is an object. To move a picture/image to a new location in your document, make sure
the picture/image is selected. Then move your cursor to any of the picture/image borders
until you get a 4‐way arrow (
). Holding down the left button on your mouse, you can
drag the entire picture/image to the new location.

ACTIVITY
Now let’s try inserting a couple of pictures/images on a page from clip art and pictures on your
computer (if available), and moving them around in relation to each other. Also try resizing the
images by using corners vs. sides.
d. Layering a Picture/Image: Publisher ships with more than 5,000 clip art images and
photographs. As discussed earlier, you can insert any of these into your publication.
However, for an even more dramatic and creative look, why not "layer" two or more
images?
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If you place two images on top of each other, the second image
you insert will obscure the first – like stacking paper.
However, you can achieve really eye‐catching results by
deciding which of the images should be on top. Like this….
Here we have two graphics, an ambulance and an EMT with a
patient, but the ambulance is partially obscuring the people, making the graphic unusable.
What you need to do is to send the ambulance image to the back, so that the image with
people can be on top. Select the ambulance image by clicking on it. Click on the Bring to
Front located on the Picture Tools Format tab.

Depending on which image you have selected and where you want it to appear in the layer,
will determine which of these options to choose. In this case
since you selected the ambulance and you want it to be behind
the image with the people, you would choose Send Backward or
Send to Back depending on how many layers (objects) are on the
page.
Note if the selected image does not appear to move, when you select Send Backward, there
are other layers and a shortcut is to choose Send to Back. The same can be applied to Bring
Forward and Bring to Front.

And suddenly your graphic takes on a whole new clarity!
Before

After

Note: when you use the Send to Back or Bring to Front options, the top graphic becomes
"transparent" and does NOT totally obscure the graphic beneath it.
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e. Rotating Objects: You can also rotate images (as well as text boxes) by placing your
cursor over the (located at the top of your image/text box) until you get a black circle
around it.
Then hold down the left mouse button and rotate the image any direction you need.
f. Grouping/Ungrouping Objects: Often when you insert multiple objects (whether
images and/or text boxes) you might want some of these objects to be adjusted, moved,
or rotated together as though one object. To do this, you would want to “Group” objects.
To group two or more objects (text boxes, image,
and/or shapes):
 Select one object by clicking on it. You would
only need to click on the object once. Selected
objects will have circles at the corners and
center points. (see example to right)


While the first object is selected, hold down the “Ctrl” key on your keyboard and
move your cursor over the other object you
want to group and click on it. Repeat this
process for any more objects you want to
group as one. When you have 2 or more
objects selected, each object will have the
circles at the corners and center points. (see
example to right)



If you right‐click on the selected
objects, a dialog box will appear
with several options. To group the
objects as one, click on the Group
option.
This option is also
available on the Home, Drawing
Tools Format, and Picture Tool
Format tabs.



All of the objects that had been
selected will be “grouped” into one
object that can later be ungrouped
if needed. Also, each object will no
longer have circles at the corners
and center points—instead there
will be one set. (see example to
right)
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The icon will then change to two overlapping squares with dots at each corner.
This option is also available on the Home, Drawing Tools Format, and Picture Tool
Format tabs. Once the objects are grouped, they can be adjusted, moved, or
rotated together as though it was one object
To ungroup two or more objects:
 To ungroup objects, select the grouped object and click on the icon shown in the
previous step. By clicking on it, the objects will be ungrouped and will no longer
be editable as a single object.
Note: once you ungroup the objects, all of the objects will be selected. If you want to modify just one of the
objects, you will need to click outside of the area and then click back on the one object you want to unselect
the other objects.

g. Transparency: Sometimes you will find an image you want to use, but the background
color is too dark or you do not want the image to have a background color. In these cases,
you will want to make the background transparent. You can create a transparent area in
most images, but not all.





Select the picture that you want to create a transparent area in
On the Picture Tools Format tab,
Click on the down arrow by Recolor and
Select the Set Transparent Color option (see image below)

Note: you will not be able to create a transparent area in all images. If this option is not available for an
image, the icon will be grayed out.
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Your cursor will change shape to look like a little marker. Move your cursor to the image
and click on the area you want to make transparent. In the following example, we wanted to
get rid of the black background to add text boxes around the transparent areas in the image.
Before

After

Then you can put a text box in front of
the image and make it part of the message.
(see example on right)

h. Cropping Images: There are times when for the purposes of your publication, you need to
crop an image. Publisher has some basic photo editing capabilities that allow you to crop an
image to a rectangular or square shape. You will find the Crop icon located on the Picture
Tools Format tab. (see image below).
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First select the image you want to crop by clicking on it with your cursor.



Then move your cursor to the Picture Tools Format
tab and click on the Crop icon. After you click on the
Crop icon the circles on the selected image will go
away and there will be dark black lines around the
image. (see example directly to right)
If you put your cursor on one of the midpoint black
lines, the cursor will look like a T. If you put your
cursor on one of the corner black lines,
the cursor will look like an L



When you move your cursor to the corner or side
you want to crop from, hold down the left button on
your mouse and move in the direction you want to
crop. You can crop from multiple directions. (see
example directly to right)
When you are done cropping an image, move your
cursor outside of the image and click. The dark
black lines will go away.

Note: You can un-crop any image you have cropped using this method. If you want to remove the cropping
on an image, just click on the image and then the Crop icon. Then move your cursor to the areas of the
image you want to un-crop and holding down the left mouse button, drag it out, down, or up.

ACTIVITY
Let’s try inserting two or more pictures/images on one page, and layering them.
Then try rotating an image or Text Box.
Try to group and then ungroup several objects.
Find an image you can use transparency on and make an area transparent.
EXTRA CREDIT:
Crop the right side of an image

7. Wrap Text: One of the really powerful
features of Publisher is its ability to "wrap
text" around another object. For example, if
you have some text in a frame (see example
to right), and you wish to place a picture in
the middle of it, Publisher allows you to do
so – and simply moves the text aside to
allow space for the graphic.
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Now watch what happens to the text when you insert a picture/image.

You can see by the above example, the Text Box extends under the picture/image (denoted by
yellow circles); however, the picture/image does not cover any of the text. Publisher automatically
wraps the text around the picture/image.

ACTIVITY
Let’s wrap some text. Feel free to add whatever text you want and insert whatever picture
you want.

8. AutoShapes: It is easy to insert ready‐made shapes
(auto shapes) into your document. Click on the down
arrow under Shapes located on the Insert tab.
As you do so, Publisher shows you all the shapes from
which you can choose.
If you choose Lines you will get some basic line shapes
to choose from. Once you have made your selection, the
cross hairs will appear again. Click and drag on your
document to "draw" the shape.

ACTIVITY
Let’s insert some AutoShapes in our document: draw a line or arrow, a block arrow, a
callout
As a bonus, add some text in the call out shape.
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9. Inserting a picture in an object: Publisher allows you to insert a picture in an AutoShape or a
vector image2
 First insert the AutoShape or vector image you want to insert a
picture into
 Right‐click the shape/image with your cursor and choose
Format AutoShape ...
 A Format AutoShape dialog box will appear.

 Go to the Colors and Lines tab and click on Fill Effects… located next to Color:
 A Fill Effects dialog box will open. Go to the Picture tab and click on Select Picture…

2

Vector images are made up of many individual, scalable objects. These objects are defined by mathematical equations rather than
pixels, so they always render at the highest quality. This means you can make a vector image as large or as small as you need and retain
a high quality image. To learn more about vector images go to this link:
http://graphicssoft.about.com/od/aboutgraphics/a/bitmapvector_2.htm
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 Navigate to where the picture is that you
want to insert inside the shape and select it
 After you select a picture to insert, you will
be able to check or uncheck:
Lock picture aspect ratio: will make sure
your picture is not distorted but might cut
off portions you want to have included –
you will need to experiment
Rotate fill effect with shape: will rotate the
picture to the same angle as the image. If
the shape is tilted, and you check this
option, the inserted picture will be tilted to
the same angle
 After you decide on your options, click on OK
 Click OK on the Format Autoshape dialog box

ACTIVITY
Let’s insert a vector image of our state in our document and insert a picture in it.
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10. Guidelines: There are 4 basic principles of design rules (Proximity, Alignment, Repetition, and
Contrast). Guidelines will help you with vertical and horizontal Alignment.
a. To add guidelines to your document, move your cursor to either ruler
b. Holding down the left button on your mouse, drag a green line out to the position on
your paper you want it to occur – this is your guideline
Ruler: for horizontal guidelines

Guideline: always green in color

Guidelines always appear as a
fine green line. They are viewable
when building your document but
are not visible in print preview, if
you print to PDF, or if you print a
paper copy.
Guidelines will help you to line up
everything vertically and
horizontally and increase the
professionalism.
Ruler: for vertical guidelines

c. To adjust a guideline, move your cursor over it without being inside of an object and
holding down the left mouse button grab and drag to the desired location
d. To delete a guideline, move your cursor over it without being inside of an object and
holding down the left mouse button grab and drag it off the edge of the page
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11. Embedding Fonts: Fonts live outside of your Publisher document. That’s why when you use
special fonts you have purchased or downloaded, others who don’t have the same fonts can’t
see them. You can solve this problem several ways:

1) Print your publication to PDF when you want to share,
2) Email the special fonts to those you will share the
publication with and have them install the fonts prior to
opening the publication,
3) Don’t use special fonts,
4) Cut the text box and paste onto page as an image, or
5) Embed the font(s) in the publication



After you have finalized your document and
before you send for review you will want to
embed any special fonts you used



Go to the File tab



Select Commercial Print Settings (see right)



Select Manage Embedded Fonts



In the Fonts dialog box, select the Embed
TrueType fonts when saving publication option
(see below)



Leave the Do not embed common system fonts
checked (see below)



Click on OK
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12. Printing: After inserting and formatting all of your text, images, and shapes you might be
finished. You should print out a copy of the document for proofing. When you are ready for a
proof or your proof has been given the ok, you will need to disseminate your document.
a. Setting up Printing Options: Publisher has a few different options than Word for printing
its documents.





First, click on the File tab
Then choose Print
Several print options will be available
Under Printer, choose which printer you want based on if color vs. black and white

Note: Printer Properties will give you more printing options



Under Settings, you can choose what area or pages you want to print



You can also select the format for the printing. Click on each one to see how it changes

Note: when you change these options, page size also changes
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You can choose the paper size for printing as well



A final option is printing single‐ or double‐sided

Note: If using the Portrait orientation, choose long edge
for printing double-sided

b. Converting to PDF: When the document is final and you want to send out electronically
or post on your website, you should convert it to a PDF document before sending or
posting. By converting your document to PDF people will not be able to change it
and everyone should be able to read it. There are several ways to create a PDF
version of your document.
 First, in the 2010 version, you might have an option called Save as Adobe PDF
This option is adequate for internal review; however, this
option does not allow for creating a high quality document (ie., your document can

appear fuzzy when you send for printing)

 Another option is to choose Save As
If your document does not have a name, name it in File name:
Then select PDF under Save as type:
Click on the Options… button
Make sure High quality printing is selected
Click OK
Note: for an even higher quality of PDF, choose Commercial Press under the Publish Options
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 A third option is go to Print under the File tab
Choose Adobe PDF from the Printer dropdown options
Click on Printer Properties located under the printer dropdown
Go to the Adobe PDF Settings tab on the Adobe PDF Document Properties
Change Standard to High Quality Print under the Default Settings: (see below)

Click OK
Click the Print button

Note: If you do not have Adobe Acrobat Pro, then there are several freeware options available. At the time this
tutorial was created, these two programs were available for free and without any malware. However, check
with your IT before downloading any programs

doPDF:http://www.fileparade.com/listing/121922/doPDF?did=10844&pid=1&ppd=search,334333599
80,dopdf,e,,c,0,,,&gclid=CM-boYCZ6rwCFewRMwodtioAbg
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